Molecular Dynamics and Docking Simulation Studies of Human Voltage Gated Sodium Channel against Neurotoxins

Vandana Saini1, Sween1, Vishal1, Amita S. Dang2, and Ajit Kumar1*

1Department of Toxicology and Computational Biology, Maharshi Dayanand University, India
2Department of Medical Biotechnology, Maharshi Dayanand University, India

Abstract

Voltage gated sodium channel (VGSC) is one of the widely distributed voltage gated ion channel among different species and has been found as different isoforms in humans. They are classified majorly on the basis of their sensitivity towards a potent neurotoxin - Tetrodotoxin (TTX) and have been attributed to many channelopathic diseases. The interactions of human VGSC (PDB 4DCK) with different neurotoxins (peptide and non-peptide) were studied using molecular docking method, to decipher the molecular interactions of these neurotoxins with gating patterns of VGSC. The study revealed that non-peptidic neurotoxins (TTX and STX) interacted loosely as compared to their peptidic counter parts (µContoxins (GIIIA, GIIIB, KIIIA and PIIIA), Hainatoxin I, III and IV) as revealed by their corresponding binding energies. MD-simulation of human VGSC was also studied for 10 ns and was observed to be coherent with earlier reports. Further in-silico deciphering of molecular events of VGSC and neurotoxins’ interaction is being carried out by our group.

ABBREVIATIONS

TTX: Tetrodotoxin; STX: Saxitoxin; VGSC: Voltage Gated Sodium Channel; PDB: Protein Data Bank; RMSD: Root Mean Square Deviation; MD: Molecular Dynamics

INTRODUCTION

Voltage-gated sodium channels (VGSCs) are membrane spanning proteins that are responsible for conducting Na+ ions to generate communication signals between different types of tissues. A total of ten isoforms of VGSCs have been identified in humans [1,2] and are classified as per their sensitivity towards neurotoxin TTX as TTX sensitive and TTX - resistant [3]. Structurally, VGSC is composed of a large α-subunit and a smaller β-subunit. The former is functional in its own and is responsible for conducting Na+ ions across axon membranes in a voltage dependent manner. The α-subunit of VGSC is composed of four domains (DI - DIV) and each domain is further composed of six trans-membrane helical segments (S1 - S6). The segment S4 of each domain is highly conserved region of VGSC and senses the voltage alterations while segments S5-S6 forms the pore for Na+ ion channeling [1]. Several channelopathic diseases have been attributed to VGSC that includes epilepsy [4,5] non-dystrophic myotonias inherited arrhymia syndromes [6-11] chronic and neuropathic pain syndromes [12,13].

VGSC has been extensively investigated at molecular level for different diseases and their therapeutic interventions using VGSC binding ligands [14-22]. The molecular interactions of neurotoxins derived from different organisms have also been put to subjective and molecular studies as well [23-26], to provide a background for therapeutic search to treat VGSC related diseases. The present study was undertaken as a step forward in similar direction to understand the binding mechanisms of peptide and non-peptide neurotoxins onto the human VGSC. This was done by performing docking and molecular - dynamic simulations of selected neurotoxins [TTX, STX, µContoxins (GIIIA, GIIIB, KIIIA and PIIIA), Hainatoxin I, III and IV].

MATERIALS AND METHODS

Collection of structure data of VGSC & Neurotoxins

Structure of human VGSC (PDB ID-4DCK) was retrieved from Protein Data Bank (www.rcsb.org). The structure (Figure 1) was
having C-terminus VGSC (A chain), calmodulin as B and FGF13 as C chain. ‘A’ chain of Human VGSC was considered for docking and MD simulation analyses hence; ‘B’ and ‘C’ chains were selectively deleted using standalone freeware UCSF Chimera [27]. The structures of non-peptidic neurotoxins (TTX & STX) were obtained from PubChem Database while that of peptidic neurotoxins i.e., contoxins (GIIIA, GIIIB, KIIIA, PIIIA), Hainatoxin I, III and IV (Figure 2) structures were retrieved from Protein Data Bank (www.rcsb.org).

Molecular dynamic simulation of human VGSC

The human VGSC (PDB - 4DCK) was initially subjected to energy minimization using Dynamics or Structure module of YASARA [28] by loading the ternary complex structure into the module. Then, YAMBER99 force field was selected in YASARA Dynamics and YASARA force field was selected in YASARA structure module. With these selection being made, the simulation was run with command - Options > Macro & Movie > Play macro and double-clicking the standard macro “em_run.mcr”. The molecular dynamics simulation was then carried out in YASARA Dynamics or Structure, where a project directory was created and the structure of ternary complex of human VGSC was stored after energy minimization. The molecular dynamics simulation was carried out after selecting the saved target molecule and following the command - Options > Macro & Movie > Play macro and double-click the standard macro “md_run.mcr”. The simulation performance was increased (when needed) by increasing the simulation steps per screen update using ‘Simulation > Timestep’ module.

Analysis of simulation trajectory of human VGSC

The data obtained after simulations were analyzed for trajectory projection. This was done by using Macro & Movie option and playing the standard analysis macro. This macro created a self-explanatory table and was saved in project directory with “.tab”- file extension. The table was then imported in the data visualization program (MS-Excel) that included energies and RMSDs from the starting structure during simulation. The standard analysis macro also calculated the time average structure, whose atoms had the B-factors (calculated from the Root Mean Square fluctuations) during simulation and the minimum energy structure was saved as ‘energymin.scf’ in the project directory. The energy minimized and stabilized structure of PDB-4DCK was selected for docking studies.

Docking analysis of TTX and STX

TTX & STX were docked against the energy optimized human VGSC as receptor and the interacting residues and binding energies were noted. The structure of human VGSC (PDB ID-4DCK) was subjected to binding pocket detection using CASTp Server (http://sts.bioe.uic.edu/castp/). For this, the Graphical User Interface program AutoDock- 4.2 [29] was used to prepare, run and analyze the docking simulations. Before docking simulation, the polar hydrogen atoms were added followed by calculation of the partial atomic charges using Gastegier and Kollman charges and all the rotatable bonds were assigned for the VGSC - receptor molecule. Auto Grid 4.2 Program, supplied with Auto Dock 4.2, was used to produce grid maps. The spacing between grid points was set to default value of 0.375 Å. The grid box size was set at 126 Å, 126 Å and 126 Å (x, y and z-axis) to include all the amino acid residues that were present in rigid macromolecules. A total of 10 independent runs per Ligand and a step sizes of 0.2 Å for translations and 5 Å for orientations and torsions and initial population of random individuals with a population sizes of 150 individuals were set as fixed parameters for all the docking analysis using genetic algorithm (GA). For GA, the maximum number of energy evaluation was set to 50000, maximum number of generations was set to 1000, and maximum number of top individual that automatically survived was set to 1 with the mutation rate of 0.02, crossover rate of 0.8, cluster tolerance 0.5 Å, external grid energy 1000.0, maximum initial energy 0.0. The Lamarckian Genetic Algorithm was chosen for generating the best conformer.
Docking of conotoxins (peptide) against VGSC

Conotoxins (GIIIA, GIIIB, KIIIA and PIIIA), Hainatoxin I, III and IV structures were retrieved from PDB and energy minimized using UCSF Chimera before subjecting them to docking studies against human VGSC. The online protein-protein docking tool server of Hex (http://www.loria.fr/~ritchiel/hex/) was used for the purpose. The default values with certain modifications were set as docking parameters. The correlation type was set for shape and electrostatic while the search order was set to 25. The angle range was set to 180° for both the receptor and ligands. The steric orientations were observed more towards segment 5 while the search order was set to 25. The angle range was set to 180° for both the receptor and ligands. The steric orientations were observed more towards segment 5 and almost parallel to S5. This finding supports the TTX/µ toxin binding model, previously proposed [32-34].

RESULTS & DISCUSSION

Docking analysis of non-peptidic neurotoxins against human VGSC

TTX and STX were the selected non-peptide ligands for study and were docked against the human VGSC as receptor and the interacting residues and binding energies were observed (Table 1). The docking simulation analyses revealed that the non-peptidic neurotoxins docked against VGSC with high binding energies of -4.96 kJ/mol and -3.39 kJ/mol, for STX and TTX, respectively. The lower binding affinities of TTX and STX can be well explained as the receptor selected for the study was of VGSC type 5 (Na1.5) and the later belongs to TTX-resistant isoform [30]. Four residues of receptor were found in common, at the interacting site while two residues were observed commonly involved in H-bonding for both the toxins (Table 1). These interacting residues were Glutamate, two Serine and Tyrosine while Tyrrosine and Glutamate were observed to be involved in H-bonding (Figure 3). Similar binding patterns have been observed earlier in other organisms [30,31] and thus well support the present investigation in human VGSC also.

Docking of peptide neurotoxins against human VGSC

The peptide neurotoxins - µConotoxins (GIIIA, GIIIB, KIIIA and PIIIA), Hainatoxin I, III and IV were docked against human VGSC using Hex server. The analyses of docking simulations revealed that the peptide neurotoxins docked against VGSC with comparatively lower binding energies (higher binding affinity) than non-peptide counterparts (TTX and STX) with values ranging from -5.26 kJ/mol to -9.79 kJ/mol (Table 2). Two methionine residues were found in common, at the interacting sites for GIIIA, Hainatoxin III and IV, while Glutamate was observed commonly involved at the interacting sites for GIIIA, GIIIB and Hainatoxin III (Table 2; Figure 3). The interactions were observed at the residues of P-loop between S5 - S6, similar to the previously reported binding site of the toxins [30,31] but the steric orientations were observed more towards segment 5 (S5) and almost parallel to S5. This finding supports the TTX/µ toxin synergym-binding model, previously proposed [32-34]. The outward parallel orientation of peptide neurotoxins gives steric permission for TTX/STX binding, simultaneously.

Molecular dynamic simulation of human VGSC

The human VGSC (PDB - 4DCK) was initially subjected to energy minimization using Dynamics or Structure module of YASARA. After running the energy minimization program, the receptor protein molecule was subjected to molecular dynamic simulation for 10 nanoseconds. The trajectory obtained for overall energy simulation of human VGSC revealed that the overall energy stabilized after a peak of -2462476.8 kJ/mol at 25 ps and remained almost in plateau phase for rest of the period (Figure 4a). Almost similar trajectories were obtained for the plots of different energy contributors against simulation run time. The contribution due to steric parameters like bond, angle, dihedral angle and planarity was found maximum at 25 ps with the values 161117.498 kJ/mol, 64077.138 kJ/mol, 35089.317 kJ/mol and 250.475 kJ/mol, respectively, which stabilized further to a stationary phase for rest of the period (50 - 700 ps) similar to the trajectory pattern of overall energy curve (Figure 4b - 4e). The contribution due to coulombian charge and Van der Waal forces was comparatively lower binding energies (higher binding affinity) than non-peptide counterparts (TTX and STX) with values ranging from -5.26 kJ/mol to -9.79 kJ/mol (Table 2). Two methionine residues were found in common, at the interacting sites for GIIIA, Hainatoxin III and IV, while Glutamate was observed commonly involved at the interacting sites for GIIIA, GIIIB and Hainatoxin III (Table 2; Figure 3). The interactions were observed at the residues of P-loop between S5 - S6, similar to the previously reported binding site of the toxins [30,31] but the steric orientations were observed more towards segment 5 (S5) and almost parallel to S5. This finding supports the TTX/µ toxin synergym-binding model, previously proposed [32-34]. The outward parallel orientation of peptide neurotoxins gives steric permission for TTX/STX binding, simultaneously.

Molecular dynamic simulation of human VGSC

The human VGSC (PDB - 4DCK) was initially subjected to energy minimization using Dynamics or Structure module of YASARA. After running the energy minimization program, the receptor protein molecule was subjected to molecular dynamic simulation for 10 nanoseconds. The trajectory obtained for overall energy simulation of human VGSC revealed that the overall energy stabilized after a peak of -2462476.8 kJ/mol at 25 ps and remained almost in plateau phase for rest of the period (Figure 4a). Almost similar trajectories were obtained for the plots of different energy contributors against simulation run time. The contribution due to steric parameters like bond, angle, dihedral angle and planarity was found maximum at 25 ps with the values 161117.498 kJ/mol, 64077.138 kJ/mol, 35089.317 kJ/mol and 250.475 kJ/mol, respectively, which stabilized further to a stationary phase for rest of the period (50 - 700 ps) similar to the trajectory pattern of overall energy curve (Figure 4b - 4e). The contribution due to coulombian charge and Van der Waal forces was lower binding energies (higher binding affinity) than non-peptide counterparts (TTX and STX) with values ranging from -5.26 kJ/mol to -9.79 kJ/mol (Table 2). Two methionine residues were found in common, at the interacting sites for GIIIA, Hainatoxin III and IV, while Glutamate was observed commonly involved at the interacting sites for GIIIA, GIIIB and Hainatoxin III (Table 2; Figure 3). The interactions were observed at the residues of P-loop between S5 - S6, similar to the previously reported binding site of the toxins [30,31] but the steric orientations were observed more towards segment 5 (S5) and almost parallel to S5. This finding supports the TTX/µ toxin synergym-binding model, previously proposed [32-34]. The outward parallel orientation of peptide neurotoxins gives steric permission for TTX/STX binding, simultaneously.

Molecular dynamic simulation of human VGSC

The human VGSC (PDB - 4DCK) was initially subjected to energy minimization using Dynamics or Structure module of YASARA. After running the energy minimization program, the receptor protein molecule was subjected to molecular dynamic simulation for 10 nanoseconds. The trajectory obtained for overall energy simulation of human VGSC revealed that the overall energy stabilized after a peak of -2462476.8 kJ/mol at 25 ps and remained almost in plateau phase for rest of the period (Figure 4a). Almost similar trajectories were obtained for the plots of different energy contributors against simulation run time. The contribution due to steric parameters like bond, angle, dihedral angle and planarity was found maximum at 25 ps with the values 161117.498 kJ/mol, 64077.138 kJ/mol, 35089.317 kJ/mol and 250.475 kJ/mol, respectively, which stabilized further to a stationary phase for rest of the period (50 - 700 ps) similar to the trajectory pattern of overall energy curve (Figure 4b - 4e). The contribution due to coulombian charge and Van der Waal forces was lower binding energies (higher binding affinity) than non-peptide counterparts (TTX and STX) with values ranging from -5.26 kJ/mol to -9.79 kJ/mol (Table 2). Two methionine residues were found in common, at the interacting sites for GIIIA, Hainatoxin III and IV, while Glutamate was observed commonly involved at the interacting sites for GIIIA, GIIIB and Hainatoxin III (Table 2; Figure 3). The interactions were observed at the residues of P-loop between S5 - S6, similar to the previously reported binding site of the toxins [30,31] but the steric orientations were observed more towards segment 5 (S5) and almost parallel to S5. This finding supports the TTX/µ toxin synergym-binding model, previously proposed [32-34]. The outward parallel orientation of peptide neurotoxins gives steric permission for TTX/STX binding, simultaneously.

Molecular dynamic simulation of human VGSC

The human VGSC (PDB - 4DCK) was initially subjected to energy minimization using Dynamics or Structure module of YASARA. After running the energy minimization program, the receptor protein molecule was subjected to molecular dynamic simulation for 10 nanoseconds. The trajectory obtained for overall energy simulation of human VGSC revealed that the overall energy stabilized after a peak of -2462476.8 kJ/mol at 25 ps and remained almost in plateau phase for rest of the period (Figure 4a). Almost similar trajectories were obtained for the plots of different energy contributors against simulation run time. The contribution due to steric parameters like bond, angle, dihedral angle and planarity was found maximum at 25 ps with the values 161117.498 kJ/mol, 64077.138 kJ/mol, 35089.317 kJ/mol and 250.475 kJ/mol, respectively, which stabilized further to a stationary phase for rest of the period (50 - 700 ps) similar to the trajectory pattern of overall energy curve (Figure 4b - 4e). The contribution due to coulombian charge and Van der Waal forces was lower binding energies (higher binding affinity) than non-peptide counterparts (TTX and STX) with values ranging from -5.26 kJ/mol to -9.79 kJ/mol (Table 2). Two methionine residues were found in common, at the interacting sites for GIIIA, Hainatoxin III and IV, while Glutamate was observed commonly involved at the interacting sites for GIIIA, GIIIB and Hainatoxin III (Table 2; Figure 3). The interactions were observed at the residues of P-loop between S5 - S6, similar to the previously reported binding site of the toxins [30,31] but the steric orientations were observed more towards segment 5 (S5) and almost parallel to S5. This finding supports the TTX/µ toxin synergym-binding model, previously proposed [32-34]. The outward parallel orientation of peptide neurotoxins gives steric permission for TTX/STX binding, simultaneously.
Table 2: Binding energy, interacting residues and H-bond residues of human VGSC (4DCK) docked against peptide neurotoxin.

<table>
<thead>
<tr>
<th>Ligand</th>
<th>Interacting residues (Ligand)</th>
<th>Interacting residues (Receptor)</th>
<th>Binding energy</th>
</tr>
</thead>
<tbody>
<tr>
<td>GIIIA</td>
<td>Ala 22, Cys 21, Cys 4, Gln 14</td>
<td>Asp 1789, Met 1875, Met 1880, Ser 1885, Gln 1890</td>
<td>-8.77 kJ/mol</td>
</tr>
<tr>
<td>GIIIB</td>
<td>Ala 22, Lys7, Asp 12</td>
<td>Ala 1882, Ser 1888, Gln 1798</td>
<td>-9.79 kJ/mol</td>
</tr>
<tr>
<td>Hainatoxin I</td>
<td>Asn 14, Tyr 20, Asp 26, Lys 7</td>
<td>Lys 1818, Ala 1882, Phe 1808, Tyr 1795, Cys 1850, Gln 1845</td>
<td>-7.26 kJ/mol</td>
</tr>
<tr>
<td>Hainatoxin III</td>
<td>Tyr 32, Cys 29, Gly 6, Lys 13, Ser 23, Cys 29</td>
<td>Met 1875, Met 1851, Ser 1888, Lys 1886, Glu 1796, Phe 1808</td>
<td>-6.77 kJ/mol</td>
</tr>
<tr>
<td>Hainatoxin IV</td>
<td>Asn 13, Gln 15, Leu 3, Trp 30, Ala 08</td>
<td>Thr 1858, Leu 1854, Phe 1794, Asp 1792, Met 1875 Met 1880</td>
<td>-7.55 kJ/mol</td>
</tr>
<tr>
<td>KIIIA</td>
<td>Cys 2, Ser 6, Arg 14</td>
<td>Phe 1879, Asn 1883, Phe 1791</td>
<td>-5.26 kJ/mol</td>
</tr>
<tr>
<td>PIIIA</td>
<td>Arg 14, His 8, Arg 2, Gln 15</td>
<td>Asp 1792, Phe 1879, Cys 1850, Tyr 1795</td>
<td>-9.33 kJ/mol</td>
</tr>
</tbody>
</table>

interactions was also in accordance to the above results and was maximum at 25 ps with the values of -3049175.844 kJ/mol and 326164.651 kJ/mol (Figure 4f - 4g). The plots tended to stabilize further and attain the plateau phase for rest of the period (50 - 700ps). These trajectory patterns supports and validates the simulation profile of the human VGSC (PDB-4DCK). The trajectory patterns of energy due to RMSDs, Backbone and Heavy atoms differed from the trajectories of other parameters contributing to the overall energy of interactions of ternary complex. The trajectory plots of energy due to RMSDs Backbone...
Figure 4c Trajectory plot of Angular Energy vs Time of human VGSC (PDB-4DCK).

Figure 4d Trajectory plot of Dihedral Angular Energy vs Time of human VGSC (PDB-4DCK).

Figure 4e Trajectory plot of Planarity Energy vs Time of human VGSC (PDB-4DCK).
Figure 4f Trajectory plot of Coulombian Charge Energy vs Time of human VGSC (PDB-4DCK).

Figure 4g Trajectory plot of Van der Waal Energy vs Time of human VGSC (PDB-4DCK).

Figure 4h Trajectory plot of RMSD (Å) vs Time of human VGSC (PDB-4DCK).
and Heavy atoms showed a continuous increase with respect to time even after 700ps (Figure 4h - 4j).

The deviation of trajectory plots of energy due to RMSDs (Å): CA, Backbone and Heavy atoms from other contributing parameters may be due to slow computational speed and performance available and needs further computational hours to carry out further simulations. Even though, the results obtained in the present study has provided a good picture of molecular dynamics of human VGSC (PDB - 4DCK) and the molecular events during interaction of the six different segments of the receptor protein.

CONCLUSION

The present study has given a very good picture of VGSC molecular action and its interactions with different neurotoxins and thus has contributed to further unravel the structure and function of VGSC and their potential as novel lead compounds in drug development. The study is primitive in the sense that the docking and MD-simulations performed needs to be further validated with other methodologies to arrive at conclusive findings and our group is working further towards the same.

REFERENCES


